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DHB-BKF & EHB Series 

Requirements 

PC Minder and Kitchen Minder have version 6.01 software 1 

Check the software on your 

PC Minder by clicking  

Help > About  

The version must be v6.01.55 or higher to function with the Prince Castle Gen2 PHU’s.  If your version is not v6.01.55 or 

higher, please go to Page 3 

New PHU’s require New Prince Castle Translator II Kits 2 

For instructions on connecting the new Prince Castle Translator II kits and configuring your New Gen2 PHU’s, go to page 7 
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Upgrading to PC Minder and Kitchen Minder 6.0 

Version 6.0 requires a valid software license and is Included with Kitchen Minder Systems shipped on or after March 20, 
2014. Regardless of the ship date, all KM2 color units have an included license. 
 
Kitchen Minder1 (KM1) Systems shipped prior to March 20, 2014 require a Paid Upgrade License upgrade. 
 
To purchase the Paid Upgrade license, pay on-line at the following Kitchen Technology Innovations link : http://

shop.onkti.com/ 

1 On the back-of-house (BOH) computer, go to 

www.goicc.com 

Click on the Burger King icon toward the top right 

of the screen 

2 Locate the correct software 

Select your country by clicking on the correct flag 
 
Find and select: 
Download v6.0 Kitchen Minder/PCMinder software  

Download and run the install KMSS package and click Next through the first four install screens, then Install, and then 

click Finish at the end. For upgrades, do not check the box when it asks if you want to use QES Minder. For 1st time in-

stallations, check the box.  Run the new version of PC Minder. 

3 

Validate that the correct version of PC Minder is installed by clicking Help, About on the top bar. The dialogue box that 

pops up should say that version 6.01.55 or higher is installed. 
4 

http://www.goicc.com/
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Upgrading to PC Minder and Kitchen Minder 6.0 (cont.) 

5 The BOH Computer should already be connected to the 

“Programming Port” of the Kitchen Minder and tested during the 

initial installation.  See your Kitchen Minder Installation guide for 

details.  

If you can successfully send data from PCMinder to the Kitchen 

Minder the connection is OK and skip to # 7. 

If data transmission fails go to #6. 

 

6 Run a communications test 

 A  B  C  

While the Kitchen Minder is on, go to 

PC Minder. Under the “Tools” tab, 

select “Communication Test”  

Enter “admin” as password when 

prompted. 

In dialogue box that pops up, select 

“Find Serial Communications Port” 

If it finds a serial communications 
port, it will indicate  which port it 
found, then move to step 10.  

If there is no port found, it will 

display an error message like the 

one shown above. 

Then check the connections 

between the computer and the 

Kitchen Minder, COM Port 

assignments in Windows Device 

Manager and USB-Serial 

Drivers .Replace any suspect 

parts and test again. 
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Upgrading to PC Minder and Kitchen Minder 6.0 (cont.) 

7 Check the software version of current Kitchen 
Minder unit by cycling power on the unit and ob-
serving the bottom right corner of the screen for 
the version number. If the version is 6.01 or higher 
skip to Page 6. If the version number is lower than 
6.01, continue to step 8.  

8 Check the version of the  Kitchen Minder unit  
(KM1 or KM2) by looking on the back of the unit  

  To upgrade the Kitchen Minder unit: 

 

a) Return to PCMinder on the BOH computer 

b) Go to the “Tools” menu on the top ribbon and scroll 

over “Device Upgrades” and select Kitchen Minder 1 

or Kitchen Minder 2 depending on which version the 

unit is.  

c) If prompted, enter “admin” as the password and 

select “OK” 

d) When the dialogue box appears showing that there 

is an upgrade, select the “Reprogram” button. 

e) Power the Kitchen Minder unit off, WAIT 10 

SECONDS, and then turn it back on, then select 

“Continue” on-screen. 

f) As progress is displayed, DO NOT use the computer 

or Kitchen Minder during the 5-10 minutes of the 

upgrade process. 

g) When “Programming Complete” is shown, select the 

“OK” button. If this upgrade fails, repeat steps a-f. If 

still unsuccessful, call ICC Tech Support. 

h) Repeat step 7 before proceeding, in order to verify 

correct software version on Kitchen Minder. 

9 
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Model Identification 

DHB-BK24AFCE 
Unit Name 

Number of 

Shelves 

Number of 

Trays per 

Shelf 

“A” is present if there 

are auxiliary timer 

bars (bars on the 

back of the unit) 

Type “CE” is present if 

the bin can be 

used outside of 

the US 

EHB24ACE 
Unit Name 

Number of 

Shelves 

Number of 

Trays per 

Shelf 

“A” is present if there 

are auxiliary timer 

bars (bars on the 

back of the unit) 

“CE” is present if 

the bin can be 

used outside of 

the US 
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Connecting and Configuring Prince Castle Translator II Kits to the Kitchen Minder 

1 

Place new Prince Castle Holding Bins on a flat surface in the location in the kitchen designated by the store manager . 
 

Each translator II box follows the below rules for the amount of bins that 
can connect to one (1) translator II box. 
 

1. One (1) 3x4 can connect to one (1) other bin of any size 
2. Excluding the 3x4 bin, you can connect any three (3) bins together to 

one (1) translator box 
 
Example:  The store would like to setup two (2) 3x4 bins and two (2) 2x4 
bins and one (1) 4x2 bin. 
 
Setup: The store would need two (2) translator II kits.  The two (2) 3x4 bins 
could connect together using one (1) translator II box.  The  remaining 
three (3) bins would connect together using the second translator II box. 

Bins may be stacked up to (4) shelves high, BUT ensure that all employees can reach product on the top shelf. 

IMPORTANT: To prevent injury, team-lift the bins  

2 Connect black power cable from the back of each holding bin to a matching grounded plug. Power unit on with 

green switch on front. 

3 

Layout Bins in store 
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Connecting and Configuring Prince Castle Translator II Kits to the Kitchen Minder (cont.) 

4 Connect Kitchen Minder to Prince Castle Translator box (PC II Box), PN 990198-10 is the kit part number. 

For each configuration chosen, (1) PC II Box and Ethernet is needed cable.  

Connect first configuration to the Kitchen Minder by plugging one end of the Ethernet cable into the COM1 port on the 

back of the Kitchen Minder and the other end into the FROM KM port on the PC II Box. 

NOTE: Verify that the black box says “PRINCE CASTLE TRANSLATOR II 980198-10” on the label of the box. If not, get a 

new box from Prince Castle or your service agency before proceeding.  

Repeat this for up to (3) configurations using the COM1, COM2, and COM3 ports on the Kitchen Minder in order but ALWAYS 
using the KITCHEN MINDER port on the Black Box  

Port labeled “FROM KM” 

connects to KM COM1, COM2 

or COM3. Port Labeled TO PHU 

connect to IN Port of 1st PHU 

NOTE: These and all cables are intended to be permanent, DO NOT remove them or the bins. 

5 Connect to First Bin : Connect each Level Shifter to the First Bin in each configuration. Plug one end of a COM cable 
into the Level Shifter and the other end into the IN (white) port on the back of the First Bin.  

6 String multiple bins together.  

If a configuration is being used that has multiple bins, 
they need to be connected. This is done by connecting 
one end of a COM cable to the OUT (black) port of the 
First Bin and the other end to the IN (white) port of the 
Second Bin. [If (3) bins are in the configuration, you will 
also need to connect a COM cable between the OUT port 
of the Second Bin to the IN port of the Third Bin.]  
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Setting Bin Addresses 

To allow Kitchen Minder to properly communicate with the bins, bin addresses need to be set as shown in the figure below. 
The figure shows all possible numbering configurations that DO NOT include 3x4 units, for those layouts, go to page 15.  

This is done using the control panel on the front of the unit. First, check what the current Bin Address is by pressing and  

holding the ACTUAL TEMP and SET-POINT buttons at the same time until the Bin Address is shown on the display. If the 

correct Bin Address is shown on all bins, proceed to next page step 10. 

NOTE: The numbering of one configuration has NO impact on the numbering of a different configuration. 

Use the above numbering layout for bins, and use only the boxes necessary. The bin closest to the Kitchen Minder will 

ALWAYS be BIN2, the next is BIN4, and last is BIN6. The lower timer bar will match the bin number (BAR2 is the lower bar 

on BIN2) and the upper bar is one number greater. If only (1) or (2) bins are used, omit the higher numbers. If any bin has 

only (1) timer bar, omit the higher number.  

Example: A 2x2 is linked to a 4x2. The 2x2 will be set to BIN2 and its bar to BAR2, the 4x2 will be set to BIN4, the lower bar 

to BAR4, and the upper bar to BAR5. 

1. To change a bin address, disconnect the 

power to the unit.  Reconnect power to the 

unit and immediately press and hold the 

ACTUAL TEMP and SETPOINT buttons. 

2. Once the red PROG light comes on, let 

go of the ACTUAL TEMP and SETPOINT 

buttons and use the up/down arrows to 

select the desired bin address. 

 

3. Use the PC Crown button to 

confirm the selection. 

 

PROG 
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Setting Bar Addresses 

To allow the bin to properly communicate with the timer bar(s), bar addresses need to be correctly set as shown in the 

table on the previous page. This is done directly on the timer bar. First, check what the current Bar Address is by 

pressing and holding the Prince Castle logo button and the down arrow button until the Bar Address is shown on the 

far right screen of the button bar.  

To change an incorrect Bar Address, follow the instructions below. 

1. To change a bar address, disconnect the power to the 

unit.  Reconnect power to the unit and immediately press 

and hold the PC button and DOWN ARROW buttons. 

 

2. Once the Bar address begins to blink, release the 

buttons.  Use the UP/DOWN ARROWS to select the 

desired bar address. 

3. Use the ENTER button to confirm the desired Bar 

address. 

Complete this for each button bar channel on all of the bins. Remember that button bars on the back of a unit are 

considered auxiliary and do not need to be separately programmed. These bars follow the programming of the bar on 

the front side of the same shelf. 

Be sure to follow the numbering system as prescribed in the figure. The numbering of one configuration has NO impact 

on the numbering of a separate configuration  
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Loading Product Profiles 

1 On BOH computer, Load Product Profiles for all 
products to be used. 

Navigate to the “Product Settings” screen 

2 To load the profile for each product, double-click in 

the “Warmer Type” column for the product. 

3 After the “Warmer Type” dialogue box pops up, click 
on the “PC Dual Temp” tab along the top.  

4 Select “Load Profile” from the buttons along 

the bottom.  
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Loading Product Profiles (cont.) 

5 Find the product being programmed in the menu 

that pops out and click on it. Match the 

abbreviation shown to the product profile that is 

loaded. 

6 When the menu pops back in, select “Save” . 

Repeat 2-6 for all products used in the store for all Day Parts. Day Parts can be changed by clicking  

on the current Day Part button towards the top.  

(If a  product profile is loaded  in one Day Part, it is not necessary  to load it again in another Day Part) 
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Programming Holding Bins for Kitchen Use 

1 Navigate to the “Program PHU” screen. Change each section to “PC Dual Temp” from 

“Duke/ PC PHU” by clicking on “Duke/ PC PHU” 

then selecting “PC Dual Temp”. 

2 

Determine how the bin grouping relates to PC Minder.  3 

For each configuration used, one row in PC Minder will be used, so 
start each new configuration in a new row, starting from the top. 
Each row represents a COM port on the Kitchen Minder (top row is 
COM1, middle is COM2, and bottom is COM3). 
 
The colors in the figure to the right show which trays correspond 
with which boxes on  PC Minder. Do not place products in the boxes 
that are not shaded.  
 
The layouts to the right  represent all bins except the 3x4 bins. For 
the specifics on how 3x4’s interact with PC Minder, visit page 15. 

NOTE: On a 2x3 unit, products must be placed in all four slots 

across in order to communicate properly with PC Minder. The prod-

ucts in the two bottom right shelves must match and the products 

on the two top right shelves must match. 
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Programming Holding Bins for Kitchen Use 

4 Based on which configurations chosen in setup, 
choose products to be held in the bins. Do this by 
clicking anywhere in a white box and selecting the 
product from the dropdown menu. 
IMPORTANT: Each half of each row in a section 
must match, if they do not, they will display in red. 
Acceptable pairings will show in blue 
 
If a tray is to be left empty, may select “-none-“.  

Select a product or “-none” for each tray on all of the 
bins for each Day Part.  

Save programming by selecting File > Save on the 
top ribbon.  

5 

6 Send Programming to Kitchen Minder by navigating 

to “Send to Kitchen Minder” Screen and selecting 

“Send Forecast”. Wait for the process is complete, it 

will take about 5 minutes. The Kitchen Minder 

should beep to validate that it is receiving data. 

Go to bins and verify that all bars display the 

correct products in the correct locations, if not, 

check through settings in step 4 and then repeat 

step 6 if necessary. 

7 

Check that the setpoint for each Zone match what 

was programmed in PCMinder, , if not, check through 

settings in step 4 and then repeat step 6 if necessary 

8 
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3x4 Special Instructions 

Bin Numbering Layout 

The 3x4 bins are programmed so that they 

can only be set to BIN2 or BIN6 because of 

their size.  

The three possibilities are that there are (2) 

3x4’s, or the 3x4 is with another size bin, 

either  first or second. 

In any case, the first bin is set to BIN2 and the 

second is BIN6. The bars correspond to the 

bins like they do with the other 

configurations. 

PC Minder Interaction 

There are two options as to how 3x4 bins interact with PC Minder. On the top of the figure on the 

right represent s how it interacts if it is set to BIN2, and the bottom shows how it interacts if it is 

BIN6. 

If there are two 3x4’s, the middle column in PC Minder will be split between the two bins. 

If another sized bin is first, it will take the first column of PC Minder, and the 3x4 will take up half of 

the middle column and the third column (bottom on right). 

If another sized bin is second, it will take the third column of PC Minder, and the 3x4 will take up the 

first column and half of the second column (top on the right). 

2 

1 

4 

3 

6 

5 


